
Hands-On with LabVIEW 

*Last revised for LabVIEW 2010 
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A Highly Productive Graphical Development Environment for Engineers and Scientists 

Custom User Interfaces 

Technology Abstractions 

Built-in Libraries 

Programming 

Approaches 

Hardware APIs 

Deployment Targets 
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Section I – LabVIEW Environment 

A.  Set up Your Hardware 

B.  Take Your First Measurement 
• Open and Explore Final Project: Audio Equalizer 

C.  Demonstration: Creating our First VI 

D.   LabVIEW Environment 

E.  Hands-On Exercise: Acquiring Data 
• Write a program that reads in a signal from a microphone 

 



5 

A. Setting Up Your Hardware 

• Data Acquisition Device (DAQ) 
– NI myDAQ 

– Configured in Measurement and Automation Explorer 
(MAX) 

 

• Sound Card 
– Available in most PCs 

– No additional configurations required 

Track A 

Track B 
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NI myDAQ 

Analog Input: 

    2 channels, 200kS/s/ch, 16-bit 

Analog Output: 

    2 channels, 200kS/s/ch, 16-bit 

DIO: 8 lines 

CTR: 1 counter 

Integrated DMM: V, A, Ohm 

Power Supply: +5V, +/-15V 

3.5mm stereo audio jacks 

ELVISmx Software Instruments 

Integrated DMM 

USB controlled,  

bus powered 

Audio IN/OUT 

8 DIO lines, 

1 counter 

Power Supply:  

+/- 15 V 

Power Supply: 

+5V 

2 AO lines 

2 AI lines 
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Demonstration: What is MAX? 
• Stands for Measurement & Automation Explorer 

• Organizes all your National Instruments hardware and software 

• Configure your hardware in MAX 

• Tests your device in MAX  
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Exercise 1 – Setting Up Your  Hardware Device 

• Use Measurement and Automation Explorer (MAX) to: 

– Configure and test your myDAQ 

Track A 
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What is an Audio Equalizer? 

• It’s a car stereo! 

• Audio Equalizers adjust the 

volume of a certain frequency 

within a signal.  

• We are going to build a 3-band 

Audio Equalizer using filters that 

affects these frequency ranges 

– Bass 

– Midtones 

– Treble 
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Let’s Explore the Final Project 

Open up the myDAQ Audio Demo.vi and play around with it. Be sure you 

have your microphone (or MP3 player) plugged in along with the 

speakers!  



14 

Time to Break it Down 

Acquire 

Gather data from your 

myDAQ or another data 

acquisition device.  

Analyze 

Extract useful information from 

your data with interactive 

wizards and more than 600 built-

in LabVIEW measurement 

analysis and signal processing 

functions.  

Present 

Visualize results in graphs and 

charts. Create custom user 

interfaces and reports in text 

files, HTML, Microsoft Word, 

Microsoft Excel, and more.  
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Types of Signals to Acquire 

Analog 

• Signal that varies continuously 

• Most commonly a voltage or 

current 

• In our case sound going into the 

microphone is converted to a 

voltage 

Digital 

• Electrical signals that transfer 

digital data  

• Usually represented by on/off, 

high/low, 0/1 
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Block Diagram Window 

Front Panel Window 

Demonstration : Creating our First VI 

Input 
Terminals 

Output 
Terminal 

Boolean 
Control 

Graph 
Indicator 
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What is the front panel 

used for? 

What are the inputs and 

outputs called? 

What is the block diagram 

used for? 

How does data travel on the 

block diagram? 

LabVIEW Environment 
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Palettes 

Bonus: How many 

of the tools can 

you name? 

Where can you find the following Palettes? 
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Data Types 

What are the following data types? 
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Toolbar 

What do the following buttons do? 



24 

Using the Search Functions 

Can you name three ways you can search for a function in 

LabVIEW? 
 

Where are the following items located? 

 
 

Feel free to reference LabVIEW to find the answers 

DAQ Assistant Waveform Chart Two Button Dialog 
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Dataflow 

Which VI(s) will execute first? Which VI will execute last? 
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Debugging Techniques 

• Execution Highlighting 
 
 

 
• Probes 

• Broken Run Arrow 
 
 
 

• Error List 
 

 

 

 

 

 

 

Are there other debugging tools 

you can think of? 

How do you use the following debugging tools? 
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Context Help Window 

How many ways to display the 

context help window can you list? 
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Commenting Your Code 

 Double-click anywhere on your front panel or block diagram 

to insert a comment 
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Tips for Working in LabVIEW 

• Keystroke Shortcuts 

– <Ctrl+H> – Activate/Deactivate Context Help Window 

– <Ctrl+B> – Remove Broken Wires from Block Diagram 

– <Ctrl+E> – Toggle between Front Panel and Block Diagram 

– <Ctrl+Z> – Undo (also in Edit menu) 

– <Ctrl+T> -- Tile Front Panel and Block Diagram 

• Tools»Options… – Set Preferences in LabVIEW 

• File»VI Properties – Configure VI Appearance, Documentation, etc. 

• Create»Control/Constant/Indicator – Right-click on terminal to create 
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Peak Detection 

• Convert Time-domain 

signals to Frequency- 

domain signals 

• Analyze all frequency 

components to find the 

dominant frequency 

• In this exercise 

– We take in the sound signal 

– Perform spectral analysis  to 

detect peak frequency 

– Display on graph 

Time 

Frequency 

30 
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Exercise 2 – Acquiring a Signal with DAQ 

This exercise should take 15 minutes. 

• Use the exercise template to: 

– Acquire a signal from your myDAQ device 

– Take a Spectral Measurement 

Do Not Delete 

Exercise 2 Instructions 
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Video: Blind Driver Challenge 

Don’t forget to submit your project to ni.com/studentdesign 

for a chance to win prizes and a trip to Austin, TX 

YouTube Link Part 1 

YouTube Link Part 2 

http://www.youtube.com/watch?v=cg3wueoz0dY
http://www.youtube.com/watch?v=0gk-_to32a4&NR=1
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Section II – Elements of Typical Programs 

A.  Demonstration: While Loops and SubVI 

B.  Loops 
• While Loop 

• For Loop 

B. Functions and SubVIs 
• Types of Functions 

• Creating Custom Functions (subVI) 

C.  Hands-On Exercise: Filtering and Outputting Sound 
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Demonstration: While Loop and SubVIs  

Dataflow and Loops SubVIs 

Bad Example Good Example 
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While Loop 

• What do the following 

terminals do? 

 

 

• How many times must 

a while loop run? 
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For Loop 

• What does the iteration terminal 

start counting from? 

 

• How many times will a for loop 

execute? 
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Drawing a Loop 

2. Enclose code to be repeated 

3. Wire up the Stop Condition 
and add any additional code.   

1. Select the structure 
(Programming»Structures) 
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3 Types of Functions 
Express VIs: interactive VIs with configurable dialog page (blue border) 

 

 
 

 

 

Standard VIs: modularized VIs customized by wiring (customizable) 

 

 

Functions: fundamental operating elements of LabVIEW; no front panel or 
block diagram (yellow) 
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LabVIEW Functions and SubVIs Operate Like 
Functions in Other Languages 

Function Pseudo Code 
function average (in1, in2, out) 

{ 

out = (in1 + in2)/2.0; 

} 

 

 

SubVI Block Diagram 

Calling Program Pseudo Code 
main 

{ 

average (in1, in2, pointavg) 

} 

 

 

Calling VI Block Diagram 
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Create SubVI 

What are some ways that you can create subVIs? 
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Icon Editor and Connector Pane 

Icon Editor 

• Why is having a good icon 

important? 

• How can you edit the icon of 

your subVI? 

Connector Pane 

• Where do you find the 

connector pane? 

• How do you add inputs or 

outputs to the connector pane? 
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Analysis: Filters 

• Allows some frequencies of a 

signal to pass more easily than 

others 

• We will be using three types of 

filters in our project 

– Lowpass   (Bass Filter) 

– Bandpass  (Midtone Filter) 

– Highpass  (Treble Filter) 
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Outputting signal to DAQ 

• Send a signal from the 

computer to your data 

acquisition device or 

sound card 

• In our case we are 

modifying the audio 

input and sending the 

signal to our speakers. 
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Exercise 3 – Outputting Sound with myDAQ 

• Use LabVIEW Express VIs to: 

– Acquire a signal  

– Apply a Filter 

– Output sound to your  

   speakers 
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Video: myDAQ Piano Staircase 

Don’t forget to submit your project to ni.com/studentdesign 

for a chance to win prizes and a trip to Austin, TX 

YouTube Video Link 

http://www.youtube.com/watch?v=M1_DW56iwSU
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Section III-Analyzing and Presenting Your Results 

A. Demonstration: Arrays and Auto-Indexing 

B. Arrays 

• Creating Arrays 

• Auto-Indexing 

B. Displaying Data on the Front Panel 

• Graphs and Charts 

C. Demonstration: Case Structures 

• Decision Making 

D. Hands-On Exercise: Audio Equalizer 
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Demonstration: Arrays 

Creating Arrays and Auto-Indexing 

Programatically Creating Arrays 
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• An array consists of elements and 

dimension. What do those terms mean? 

• When would you use an array? 

• In LabVIEW, what is the index of the 

first element in an array? 

Arrays 
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Creating an Array 
From the Controls»Modern»Array, Matrix, and Cluster 

subpalette, select the Array icon 

1. Place an array shell on the front panel 

2. Drag a data object or element into the array shell 

Empty array shell as seen 
on the  block diagram.  
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• Loops can accumulate 

arrays at their boundaries 

with auto-indexing 

• For loops auto-index by 

default 

• While loops output only 

the final value by default 

 

• How can you 

enable/disable auto-

indexing? 

 

Building Arrays with Loops (Auto-Indexing) 

Wire becomes thicker 

Wire remains the same size 

Auto-Indexing Disabled 

Auto-Indexing Enabled 

Only one value (last iteration) 

is passed out of the loop 

1D Array 

0     1     2     3    4     5 

5 
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Waveform chart – special numeric indicator that can display a 
history of values. Charts add 1 data point at a time with history.  
 

•  Chart updates with each individual point it receives 

•  Controls»Express»Graph Indicators»Chart 

66 

Waveform Charts 
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Waveform Graphs 
Waveform graph – special numeric indicator that displays an 
array of data. A graph displays many data points at once 
  

•  Graph updates after all points have been collected 

•  May be used in a loop if VI collects buffers of data 

• Controls»Express»Graph Indicators»Graph 
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Control and Indicator Properties 
• Properties are characteristics or qualities about an object 

• Properties can be found by right-clicking on a control or 

indicator 

• Properties include: 

– Size 

– Color 

– Plot style 

– Plot color 

• Features include: 

– Cursors 

– Scaling 
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Demonstration: Case Structures 



70 

How Do I Make Decisions in LabVIEW? 
1. Case Structures 

 

 

 

 

 

2. Select 

 

(a) (b) 

(c) 

70 



71 

Tab Control 

• Keep your front panel 

organized 

• Add a new Tabs for new 

operations 

• Use the Tab control to 

select operations and 

perform different 

analyses 
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Exercise 4- Building an Audio Equalizer 

• Complete your 3 band 

equalizer 

• Become familiar with 

Case Structures  
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Video: Mind Controlled Wheelchair 

Don’t forget to submit your project to ni.com/studentdesign 

for a chance to win prizes and a trip to Austin, TX 

YouTube Link 

http://www.youtube.com/watch?v=67Gl1DnMVco


81 

Section IV – Timing and File I/O 

A. Demonstration: Timing a While Loop 

B. Timing Loops 

C. File I/O 

D. Hands-On Exercise: Adding a Karaoke Machine 
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Demonstration: Timing a Loop 

Vs. 
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How Do I Time a Loop? 
1. Configure the Time Delay Express VI for seconds to wait each 

iteration of the loop (works on for and while loops). 

2. Configure the Wait and Wait Next ms Multiple for milliseconds to 
wait for each iteration of the loop 

 

Time Delay Wait Wait Until Next ms Multiple 
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File I/O 
File I/O – passing data to and from files 

•  Files can be binary, text, or spreadsheet 

•  Write/Read LabVIEW Measurements file (*.lvm) 

Writing to *.lvm file Reading from *.lvm file 
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Karaoke! 

• Stereo sound has two 

channels: left and right 

• Sound is recorded using 

two strategically placed 

microphones  

• Voice is present in both 

channels 

• Subtract left channel from 

right channel to eliminate 

voice 
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Exercise 5 – Adding Karaoke Functionality 

• Expand Audio Equalizer 

program to include Karaoke 

functionality 
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Do Not Delete 

Exercise 5 Instructions 
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Video: myDAQ Optical Theramin 

Don’t forget to submit your project to ni.com/studentdesign 

for a chance to win prizes and a trip to Austin, TX 

YouTube Link 

http://www.youtube.com/watch?v=yvQO_Pmk8uo
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Section IV – Advanced Data flow Topics (Optional) 

A. Additional Data Types 
• Cluster 

 

B. Data flow Constructs 
• Shift Register 

• Local Variables 

 

C. Large Application Development 
• Navigator Window 

• LabVIEW Projects 
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Introduction to Clusters 
• Data structure that groups data together 

• Data may be of different types 

• Analogous to struct in ANSI C 

• Elements must be either all controls or all indicators 

• Thought of as wires bundled into a cable  

• Order is important 
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Creating a Cluster 
1. Select a Cluster shell. 
2. Place objects inside the shell. 
 
Controls»Modern»Array, Matrix & Cluster 

98 
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Cluster Functions 

• In the Cluster & Variant subpalette of the Programming 
palette 

• Can also be accessed by right-clicking the cluster terminal 

Bundle 

(Terminal labels 
reflect data type) 

Bundle By Name 
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Using Arrays and Clusters with Graphs 

The waveform data type contains 3 pieces of data: 

• t0 = Start time 

• dt = Time between samples 

• Y = Array of Y magnitudes 

 

You can create a waveform cluster in two ways: 

Build Waveform (absolute time) Cluster (relative time) 
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Shift Register – Access Previous Loop Data 

• Available at left or right border of loop structures 

• Right-click the border and select Add Shift Register  

• Right terminal stores data on completion of iteration 

• Left terminal provides stored data at beginning of next iteration 

Before 
Loop 

Begins 
First  

Iteration 
Second 
Iteration  

Last 
Iteration  

Value 15 Initial 
Value 
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Local Variables 
• Local variables allow data to be passed between parallel loops 

• You can read or write a single control or indicator from more than one 

location in the program 

– Local variables break the dataflow paradigm and should be used sparingly 
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LabVIEW Navigation Window 

• Shows the current region 
of view compared to entire 
front panel or block 
diagram 

• Great for large programs 
 

Organize and reduce program visual size with subVIs 
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LabVIEW Project 

• Group and organize VIs 

• Manage hardware and I/O 

• Manage VIs for multiple targets 

• Build libraries and executables 

• Manage large LabVIEW applications 

• Enable version tracking and management 
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NI Multisim and Ultiboard 
 

 

• World’s most popular software for  

learning electronics 

• 180,000 industrial and academic users 

• Products include: 

– Multisim simulation and capture 

– Ultiboard PCB layout 

– Multisim MCU Module microcontroller simulation 

• Low-cost student editions available 

• ni.com/multisim 
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Multisim Integrated with LabVIEW 
1. Create Schematic 2. Virtual Breadboard 3. Simulate 

4. PCB Layout 5. Test 6. Compare 
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Additional Resources 
• NI Academic Web and Student Corner 

– ni.com/students 

– ni.com/lv101 

– ni.com/textbooks 

– Get your own copy of the  

LabVIEW Student Edition 

 

• NI KnowledgeBase 

– ni.com/kb 

 

• NI Developer Zone 

–  ni.com/devzone 

 

• LabVIEW Certification 

– LabVIEW Fundamentals Exam (free on ni.com/academic) 

– Certified LabVIEW Associate Developer Exam (industry-recognized certification) 

 

ni.com/lv101 

http://www.ni.com/textbooks
http://www.ni.com/textbooks
http://www.ni.com/textbooks
http://www.ni.com/textbooks
http://www.ni.com/textbooks
http://www.ni.com/kb
http://www.ni.com/devzone
http://www.ni.com/devzone
http://www.ni.com/academic
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The LabVIEW Certification Program 

Certified LabVIEW 

Developer  

 

Certified LabVIEW Associate 

Developer 

Certified  

LabVIEW  

Architect 

Architect 
• Mastery of LabVIEW  

• Expert in large application development 

• Skilled in leading project teams 

Developer 
• Advanced LabVIEW knowledge and 

application development experience 

• Project management skills 

Associate Developer 
• Proficiency in navigating the 

 LabVIEW environment 

• Some application  

  development experience 

 
Fundamentals Exam 
•Pre-certification skills test Free Online Fundamentals Exam 
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Your Next Step 

LabVIEW Skills Evaluation Quiz: 
https://lumen.ni.com/nicif/us/infolvcoursefinder/content.xhtml 

CLAD Exam Practice: 

https://lumen.ni.com/nicif/us/ekitcladexmprp/content.xhtml 

CLAD Exam Prep Webcast: 

http://zone.ni.com/wv/app/doc/p/id/wv-566 

 

 

 

 

       

           Your first step to LabVIEW certification! 

https://lumen.ni.com/nicif/us/infolvcoursefinder/content.xhtml
https://lumen.ni.com/nicif/us/ekitcladexmprp/content.xhtml
http://zone.ni.com/wv/app/doc/p/id/wv-566
http://zone.ni.com/wv/app/doc/p/id/wv-566
http://zone.ni.com/wv/app/doc/p/id/wv-566

